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President’s Message - Yomar Cleary
Hello Everyone,

The Big Bear Computer Club board is made up of a wonderful group of dedicated
computer club members. So, I would like to introduce to you the board:
Marc Busch, Vice President & Equipment Chair….
Rosemary Lloyd, Past President & Webmaster...
Bill Flanagan, Assistant Webmaster….Tom Brandau, Treasurer
Sandi Ybarra, Secretary & Historian…...Jerri Merino, Director
Del Johnson, Director at Large …...Bill Treadwell, Director at Large & Newsletter Editor
Sharon Teeter, Refreshments and Angie Pezina, Sunshine Chair.
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NEXT CLUB MEETING
March 6, 2018
1:30 - 3:00 pm

If it's Connected,
it needs to be Protected!

Bob Gostischa from Avast Software
This presentation will cover: Computers (Windows
and Mac), Tablets, Phones and the IoT (Internet of
Things). Join presenter Bob Gostischa, as he explains
the current dangers that face us every day. He’ll also
share what he uses to keep his computers, smart
devices and other connected things that are a part of
the IoT secure.
To be held at the
Big Bear Senior Center,
42651 Big Bear Blvd
Big Bear Lake
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Can a Video Game Train You To Hear Better In a Crowded Room?
A new study finds it’s possible to
teach the brain to better distinguish
between speech and background
noise
By Dana Boebinger, The Conversation
SMITHSONIAN.COM

Roughly 15 percent of Americans
report some sort of hearing difficulty;
trouble understanding conversations
in noisy environments is one of the
most common complaints.
Unfortunately, there’s not much
doctors or audiologists can do.
Hearing aids can amplify things for
ears that can’t quite pick up certain
sounds, but they don’t distinguish
between the voice of a friend at a
party and the music in the
background. The problem is not only
one of technology, but also of brain
wiring.
Most hearing aid users say that even
with their hearing aids, they still have
difficulty communicating in noisy
environments. As a neuroscientist
who studies speech perception, this
issue is prominent in much of my own
research, as well as that of many
others. The reason isn’t that they
can’t hear the sounds; it’s that their
brains can’t pick out the conversation
from the background chatter.
Harvard neuroscientists Dan
Polley and Jonathon Whitton may
have found a solution, by harnessing
the brain’s incredible ability to learn
and change itself. They have
discovered that it may be possible for
the brain to relearn how to distinguish
between speech and noise. And the
key to learning that skill could be a
video game.
The hearing brain
People with hearing aids often report
being frustrated with how their
hearing aids handle noisy situations;
it’s a key reason many people with
hearing loss don’t wear hearing aids,
even if they own them. People with
untreated hearing loss – including
those who don’t wear their hearing
aids – are at increased risk of social
isolation, depression and
even dementia.
For many people with hearing
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difficulties, the problem isn’t in their
ears – it’s in their brain. In everyday
environments, sound waves emitted
from every object around you mix
together before they enter your ear.
Your brain must then sort out which
bits of sound belong to each source in
the environment and correctly group
these bits of sound together, ignoring
some – like the hum of the

edges of a hidden shape. They get
continuous auditory feedback on how
they’re doing through headphones,
which play sounds partially obscured
by background noise. It works a bit
like the “hotter or colder” children’s
game: The only way to find the edges
of the shape is to listen carefully to
the sounds and notice how they
change as they move their finger. As
the

refrigerator – and focusing on others,
like a relative calling out from the next
room.
This ability to distinguish, process and
make sense of sound is one of the first
things to break down in hearing loss
from normal aging, or from
neurological disorders like ADD/
ADHD, autism and dyslexia. It’s so
complex that for decades, auditory
neuroscientists like me have been
trying to understand how the brain
does this, and how we can help
people who have difficulty hearing in
noisy surroundings.
The path sound takes into the ear and
then into the brain. (Zina Deretsky,
National Science Foundation)
Video games to the rescue
In their new study, Polley, Whitton
and their colleagues created a video
game to train players’ brains to
distinguish sounds better. Players
trace their fingers around a blank
tablet screen, seeking to identify the

player gets better at the game, the
background noise gets louder, making
the game more challenging.
To determine whether this video
game could help people in their
everyday lives, the researchers
recruited 24 older adults with hearing
loss. Half of the participants played
the auditory training game. The other
12 played an equally challenging game
in which they heard nonsense
sentences (like “Ready Barron, go to
green four now”) amid background
noise. Those people had to
remember, and later identify, which
words they had heard in the
sentences. Importantly, this memory
task tested hearing, but differed from
the video game training in that it did
not test people’s ability to distinguish
subtle differences in sounds.
After eight weeks of training on their
respective games, in several sessions a
week at home on a tablet, the
Continued page 3
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Continued… Hearing
memory group was no better at
distinguishing speech from
background noise. But the people
who played the auditory video game
were able to understand 25 percent
more words and sentences in
background noise, which was about
three times more beneficial than from
their hearing aids alone. This was
particularly surprising because the
video game group showed
improvements in speech
understanding, even though their
training only involved non-verbal
sounds.
Fast feedback
In conversations and interviews,
Polley admits that he doesn’t know
exactly why the game works, but he
suspects that the structure of the
game is the key: The brain is able to
predict how the video game’s sound
will change with each finger
movement, and then gets immediate
feedback about what actually
happened.
This is the same sort of feedback that
people receive during activities like
sports and playing a musical
instrument. For example, a

violinist anticipates the next note of a
piece, places her finger on the
appropriate spot along the neck of the
violin, and then listens to the sound of
the resulting note and how it fits with
the other instruments of the
orchestra. If any pitch adjustments are
needed, her finger almost
immediately shifts to the correct spot.
And she must do all of this
while ignoring extraneous sounds, like
the other melody in the woodwind
section or the timpani drumroll.
There is some evidence that periods
of intense musical training, especially
in childhood, can lead to benefits that
generalize to everyday
communication. For example, my
previous work examined the idea
that musicians often outperform nonmusicians on tests of speech
understanding in background noise,
and that musicians’ brains might
process speech sounds more precisely
than the brains of non-musicians.
But just like musical training, practice
seems to be necessary for maintaining
the ability to understand speech in
noisy backgrounds. Two months
after the video game training ended,
the researchers tested the
participants’ speech understanding

abilities again, and found that the
benefits of the video game had
vanished.
A future with better hearing
Despite the remaining mysteries
about how exactly this sound-based
video game can improve speech
perception, this preliminary result
raises exciting possibilities for future
clinical therapies. It also gives
scientists like me further insight into
how the brain learns new perceptual
skills, by demonstrating that even
short-term training can have a
dramatic effect on ability to
distinguish speech from background
noise.
But what remains to be seen is which
brain changes underlie these
behavioral improvements. In my own
research, I seek to answer that
question by examining the brains of
people who have undergone various
types of training, observing how their
brains process sound, and comparing
them to people who have not
undergone training. The hope is that
we can learn more about how the
brain changes in response to training,
and how that relates to people’s
perceptual abilities.
So although people should
be cautious about claims about
training our brains to improve our
general intelligence, this study’s
results from targeted perceptual
training are encouraging. One day
there might be an iPhone app that can
help your mother-in-law follow the
conversation at a crowded restaurant
or a student with a learning disorder
focus on the teacher’s voice. Scientists
just need to figure out how to best
train the brain to listen.

This article was originally published
on The Conversation.
image: https://
counter.theconversation.com/
content/89218/count.gif
Dana Boebinger, Ph.D. student in
Speech and Hearing Bioscience and
Technology, Harvard University.
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New way of STEALING...
Resource Snopes.com
ESPECIALLY LOOK AT SCENE THREE...

The thief broke into his
locker at the gym and
switched cards.

Be sure to read Scene 3. Quite
interesting. This is a new one. People Verdict: The credit
sure stay busy trying to cheat us, don't card issuer said since
they?
he did not report the
card missing
============================
earlier, he would have
SCENE 1.
to pay the amount
A friend went to the local gym and
owed to them.
placed his belongings in the locker.
After the workout and a shower, he
How much did he have
came out, saw the locker open,
to pay for items he did
and thought to himself,
not buy?
'Funny, I thought I locked the locker...

$9,000! Why were
there no calls made to
Hmm, 'He dressed and just flipped the verify the amount
wallet To make sure all was in order.
swiped?

Everything looked okay - all cards
were in place...
A few weeks later his credit card bill
came - a whooping bill of $14,000!

Small amounts rarely trigger a
'warning bell' with some credit card
companies. It just so happens that all
the small amounts added up to a big
one!
============================

She took it back, apologized, and
hurried back to the counter under the
watchful eye of the man.

All the waitress did while walking to
the counter was wave the wrong
He called the credit card company and
expired card to the counter cashier,
started yelling at them, saying that he SCENE 2.
and the counter cashier immediately
did not make the transactions.
A man at a local restaurant paid for his looked down and took out the real
meal with his credit card.
card.
Customer care personnel verified that
there was no mistake in the system
The bill for the meal came, he signed it No exchange of words -- nothing!
And asked if his card had been
and the waitress folded the receipt
She took it and came back to the man
stolen...
And passed the credit card along.
with an apology...(This scenario
actually happened to me at a local
'No,' he said, but then took out his
Usually, he would just take it and
restaurant - Falls Terrace - between
wallet, pulled
place it in his wallet or pocket.
the waitress and the front desk
out the credit card, and yep Funny enough, though, he actually
cashier)
took a look at the card and,
you guessed it - a switch had been
lo and behold, it was the expired card Verdict Make sure the credit cards in
made.
of another person.
your wallet are yours.
An expired similar credit card from the He called the waitress and she looked
same bank was in the wallet.
perplexed.
http://bigbearcc.org

Continued page 5...
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Continued page 5...

the counter as he waited for the

Check the name on the card every
time you sign for something and/or

approval, which is pretty
standard procedure.

the card is taken away for even a
short period of time.

While he waited, he picked
up his cell phone and started
dialing.

Many people just take back the credit
card without even looking at it,
I noticed the phone because
'assuming' that it has to be theirs.
it is the same model I have,
but nothing seemed out of
FOR YOUR OWN SAKE, DEVELOP THE the ordinary.
HABIT OF CHECKING YOUR CREDIT
Then I heard a click that sounded like
CARD EACH TIME IT IS RETURNED TO my phone sounds when I take a
YOU AFTER A TRANSACTION!
picture.
============================
SCENE 3:
Yesterday I went into a pizza
restaurant to pick up an order that I
had called in.

He then gave me back my card but
kept the phone in his hand as if he
was still pressing buttons.

He set his phone on the counter,
leaving it open.

About five seconds later, I heard the
chime that tells you that the picture
has been saved.
Now I'm standing there struggling
with the fact that this boy just took a
picture of my credit card.

Meanwhile, I'm thinking: I wonder
Yes, he played it off well, because had
what he is taking a picture f, oblivious we not had the same kind of phone, I
probably would never have known
what happened.
Needless to say, I immediately
canceled that card as I was walking
out of the pizza parlor.
All I am saying is, be aware of your
surroundings at all times.
Whenever you are using your credit
card take caution and don't be
careless.
Notice who is standing near you and
what they are doing when you use
your card.
to what was really going on.

I paid by using my Visa Check Card
which, of course, is linked directly to
my checking account.
The young man behind the counter
took my card, swiped it, then laid it on
http://bigbearcc.org

It then dawned on me: the only thing
there was my credit card, so now I'm
paying close attention to what he is
doing..

Be aware of phones, because many
have a camera phone these days.
Never let your card out of your sight...
check and check again!
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Major Websites taking silent Anti-ad-blocking measures
Resource: Tugnet Newsletter February The researchers visited thousands of
2018 Vol 25 No 2
sites multiple times, with and without
ad-blocking software added to the
By Devin Coldeway, TechCrunch
browser. By comparing the final
rendered code of the page for blocking
browsers versus non-blocking
browsers, they could see when pages
changed content or noted the
presence of a blocker, even if they
didn’t notify the user.

It’s no secret that ad blockers are
putting a dent in advertising-based
business models on the web. This has
produced a range of reactions, from
relatively polite whitelisting asks
(TechCrunch does this) to dynamic
redeployment of ads to avoid
blocking. A new study finds that nearly
a third of the top 10,000 sites on the
web are taking ad blocking
countermeasures, many silent and
highly sophisticated.
Seeing the uptick in anti-ad-blocking
tech, University of Iowa and UC
Riverside researchers decided to
perform a closer scrutiny (PDF) of
major sites than had previously been
done. Earlier estimates, based largely
on visible or obvious anti-ad-blocking
means such as pop-ups or broken
content, suggested that somewhere
be-tween 1 and 5 percent of popular
sites were doing this — but the real
number seems to be an order of
magnitude higher.
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As you can see above, (on prior page)
30.5 percent of the top 10,000 sites on
the web as measured by Alexa are
using some sort of ad-blocker
detection, and 38.2 percent of the top
1,000. (Again, TechCrunch is among
these, but to my knowledge we just
ask visitors to whitelist the site.)

Sites can simply record this for their
own purposes (perhaps to gauge the
necessity of responding) or redeploy
ads in such a way that the detected ad
blocker won’t catch.
In addition to detecting these new and
increasingly common measures being
taken by advertisers, the researchers
suggest some ways that current ad
blockers may be able to continue
functioning as intended.
One way involves dynamically
rewriting the JavaScript code that
checks for a blocker, forcing it to think
there is no blocker. However, this
could break some sites that render as
if there is no blocker when there
actually is.

Our results show that anti-adblockers
are much more pervasive than
previously reported…our hypothesis is
that a much larger fraction of websites
than previously reported are
“worried” about adblockers but many
are not employing retaliatory actions
against adblocking users yet.

A second method identifies the “bait”
content and fails to block it, making
the site think there’s no blocker in the
browser and therefore render ads as
normal — except the real ads will be
blocked. That will, of course, provoke
new and even more sophisticated
measures by the advertisers, and so
It turns out that many ad providers are on. As the paper concludes:
offering anti-blocking tech in the form
To keep up the pressure on publishers
of scripts that produce a variety of
and advertisers in the long term, we
“bait” content that’s ad-like — for
believe it is crucial that adblockers
instance, images or elements named
keep pace with anti-adblockers in the
and tagged in such a way that they will
rap-idly escalating technological arms
trigger ad blockers, tipping the site off.
race. Our work represents an
The pattern of blocking, for instance
important step in this direction.
not loading any divs marked
“banner_ad” but loading images with The study has been submitted for
“banner” in the description, further
consideration at the Network and
illuminates the type and depth of ad
Distributed Systems Security
blocking being enforced by the
Symposium in February of 2018.
browser.
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Facebook Games
Resource: Dummies.com

Perhaps you’re the sort who enjoys playing games? Whether you like action,
making your own creation, or trying your hand at games of chance, you can
find a place to play on Facebook. Follow the quick links in this table to popular
interactive Facebook games.

Fun Facebook Applications:
Application

URL

What It Does

Farmville

www.facebook.com/
FarmVille

Build your own virtual farm and share with other
online farmers.

Frontierville

www.facebook.com/
frontierville

Indulge your inner cowboy in this Wild West
social adventure game.

Texas HoldEm
Poker

www.facebook.com/
TexasHoldEmPoker

If you fancy yourself to be the next Amarillo Slim,
here’s where you get your chops.

Pet
Society

www.facebook.com/
petsociety

Create and raise a virtual pet. Win coins, shop,
and more.

Mafia Wars

www.facebook.com/
MafiaWars

Build your own organizationand wreck virtual
havoc.

Quiz
Planet

www.facebook.com/
makequizzes

Make fun quizzes to engage your friends.

http://bigbearcc.org
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Big Bear Computer Club News

You Can Support the
Big Bear
Computer Club
at
NO COST TO YOU
By using AmazonSmile!
Big Bear Computer Club
Board News
If you would like to
know more in-depth
information about computer
technology or software programs,
The Computer Club can organize a
2018 workshop around that request.
To schedule the workshop we will
need at least 10 people to attend the
workshop.
Please direct your inquiry to Yomar.
Yomar is our President. Her contact
information is listed on page 15 in the
key leaders section.
Your Computer Club donation
is tax deductible.
Donations are accepted
though Paypal.

You do not need a Paypal
account to donate
through Paypal.

http://bigbearcc.org

The Computer Club can recycle
you old printer
cartridges
and cell
phones.

Bring them
to a club
meeting and
we will take
them off
your hands!
A simple way
for the club
to raise some
funds.

Big Bear Computer Club
Forum
The Big Bear Computer Club
has a Discussion Computer
Forum on a local Big Bear
internet information site.
Here’s a link to the directly take
you into the forum:

For each Amazon purchase you,
complete, Amazon will donate
0.5% of the purchase price to
the Big Bear Computer Club.
Below is the link from Amazon
Smile that will take you directly
to the Big Bear Computer Club
Amazon support page:
https://smile.amazon.com/ch/74
-3131147
You can consider sharing this
link with your family and friends
so they too can support the Big
Bear Computer Club.

Big Bear Computer Club
Live Website Links


Club Bylaws



Standing Rules & Policies



Board Meeting Minutes



BBC Cash Flow Statements

www.socalmountains.com
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To Win 10 0r Not to Win 10
By Art Gresham, Editor, Under the
Computer Hood User Group, CA
January 2018 issue, Drive Light
www.uchug.org

satisfactory. Another seems to have
gotten better (maybe some updates
that changed?)

But as a result, I received one system
This is a true story about how a recent (computer, monitor, keyboard) to
upgrade to Windows 10 went on one dispose of. Being the cheap sort, I had
computer.
not donated it to a recycler, thinking

cursor, text to speech etc.) could still
be updated. The cutoff for that
program is 31 December 2017.
Thought it would be worth a try, and
at the very least, an educational
experience.

So, I followed the instructions from
CNET:
Here's how to get the upgrade
at no charge:
From a Windows 7 or 8.1
device, go to the webpage
entitled "Windows 10 free
upgrade for customers who
use assistive technologies."
Click on the Upgrade now
button. Run the executable file
to install the upgrade.

The background of this upgrade is
about a desktop computer at work.
We had purchased three HP Prodesk
405 computers for our office staff.
Over the next couple years, they each
developed a recurring failure by
unexpectedly scrambling the video
making them useless. The only fix was
to force-power off-restart. After which
they would run days or weeks without
a problem.
Ultimately all three users became
aware that the problem was a
common shared problem and brought
it to my attention. We tried various
‘fixes’, looked online for help,
reinstalled drivers. Nothing seemed to
solve it. And there seemed to be no
common activity that caused it like a
browser, web page, running
application. Gradually two of these
were replaced by other, more friendly,
units. One administrator began testing
a Chromebook which has proven very
http://bigbearcc.org

maybe I could yet find a way to salvage
this otherwise very functional, newer
than most of our computers, powerful
box. Months passed.
Late in November I plugged it in and
began experimenting - nothing to lose
since it had been basically written off.
Since it was a Windows 7 system I
thought that perhaps an upgrade to
Windows 10 might solve the problem,
IF it is a software (drivers?) issue.
So, I began the process of an upgrade.
Now note that my decision to start
this upgrade began well after the July
2017 cutoff on when Microsoft had
provided free upgrades. And purchase
of a copy was out of the question.
However some of the helpful sites that
I subscribe (CNET) to had published an
article in November documenting the
fact that Microsoft had extended the
offer under certain circumstances.
Specifically, systems using assistive
technologies, (magnifying, large

Now to back up and tell you more of
the story. Our (school) network is
shared by a lot of users. Sometimes
the download time can be rather slow
as lots of them (over 100 students,
plus teachers and staff, plus
Chromecast devices, Wi-Fi
thermostats, wireless printers etc.) all
compete for the space on the various
routers, through the firewall, and out
to the ISP. So, experience has taught
me that a major download (such as
the major updates to Windows 10 that
have come out over the last year) can
take many hours to succeed. I am
patient, and this is not a priority so
sure I can just let it run and work on
other things. And it runs. Hours. And
fails. Multiple attempts, each getting a
little farther until it actually starts the
upgrade process. Which then fails.
Because this (senior administrator’s)
computer had been protected by the
HP Drive Encryption service the
Continued Page 10...
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Continued … Win 10

update process would not complete
until that was removed. Google that
for the solution. It was not easy, again
involving multiple steps to Stop the
service, shut off the service, unencrypt
the drive (again…. hours), uninstall the
service. Delete the program. This will
not be a problem for most computers,
but it was a complication that had to
be solved outside of the Microsoft
upgrade process.

Media Creation Tool. Again, hours to
download. Optionally it can be loaded
to a thumb drive, or run direct from
the hard drive. So, I start running it
from the hard drive. Again hours. A
couple more failed to run, restart, run
again. Until at last a successful start
and run of the Windows 10. By now it
is a week later. And the Windows 10
upgrade, begun about 8:30 completed
by 9:45. And it all looks good. Old files
still in place, everything looks to be

running. Now to let it run a couple
days to see if the video crashes. After
over two years of frustration maybe I
am on the road home to recovering
this desktop computer. Only problem
now is that no one really wants it.
Everybody wants to have one of the
new 15-inch Chromebooks.
Oh well. Something new learned.
Something good accomplished..

And again, restart the upgrade. Which
went back to the Download the
Upgrade process….. Hours!. And when
it finally started, it….. Failed! This time
with a Windows error message
window-10-upgrade-failed-errorc1900208. And again, Internet to the
rescue. A search turned up the answer
at an infopackets.com answer
This suggested a couple solutions,
including downloading the Windows
10

http://bigbearcc.org
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About Bearly Bytes
Bearly Bytes Newsletter, past winner of SWUGC & APCUG
Newsletter contests, is the official publication of the Big Bear
Computer Club. Views expressed in Bearly Bytes are those of
the authors and do not necessarily reflect the opinions of Big
Bear Computer Club. Other computer user groups are welcome
to reprint our articles as long as they give credit to the author
and Bearly Bytes, Big Bear Computer Club.
Submissions: All BBCC members are encouraged to send letters,
articles, questions, and comments to Bearly Bytes for inclusion
in future issues. Submit as plain text in the body of an email
and attach any graphics as JPEG or GIF format and send
to: treadwell@bigbearcc.org

Bits & Bytes
February 2018 Club Meeting
Back-ups
Presented by Marc Busch (Club Vice President)
The practice of backing up your devices—why it is
prudent, and what are the best backup methods
to use

The Opportunity Drawing Winners

left to right ...
Sharon Teeter ..........Cooler bag
Carolyn Parsen…...….White Board
Jerry Parsen……...…..Scissors

Enter "Find the Bear"
contest to win a cool prize
1.
2.
3.
4.

Locate this "BEAR"
Click on it
Fill in the form
and then Send

At the next general meeting following this newsletter,
a drawing will be held for all who found the bear. The
selected winner will receive a surprise gift.
You will need to attend the meeting
in order to receive the prize

http://bigbearcc.org
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Upcoming Calendar Events

Group Newsletter Sites
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Word Tips

Excel Tips

Tip

Sending Drawing Objects to
the Back or Front in Excel

Google turns on default
adblocker within Chrome

By Rosemary Lloyd

Word Can Autocorrect
Capitalizations
Applies To: Word 2013 and more
If you're terrible at making sure all of
your words are properly capitalized,
Word has your back. Click on the File
tab > Options > Proofing > AutoCorrect Options > AutoCorrect tab. Click
all of the boxes in this tab to ensure
that Word will correct your text automatically if you type two capital
letters in one sentence, forget to
capitalize a day of the week or the
first word in a sentence, or accidentally tap on the caps lock button.
Then click OK, and then OK again to
finish.

By Yomar Cleary

When you create objects in Excel using
the Shapes tool on the Insert tab of
the ribbon, each object is drawn on its
own layer. This means all objects are
independent and can be moved on top
of other objects. However, there may
be times when you actually want an
object to be under another object. You
can do this by following these steps:

1.Click on the shape whose order you
want to change. Small square boxes
called handles appear around the
perimeter of the shape.

2.Display the Format tab of the
ribbon.

https://www.cnet.com/how-to/
microsoft-word-tips-to-make-you-apower-user/

3.In the Arrange group, click Send
Backward or, if you are using Excel
2007, click Send to Back.
You can do the same sort of
arrangement by choosing Bring
Forward instead of Send Backward or
Bring to Front instead of Send to Back
(Excel 2007). Excel will move an item
which may be behind others so that it
overlays the others.

Users of latest Chrome browser on
Windows, Mac OS, Linux and
Android will have some of most
intrusive types of ads blocked
automatically
Google will start automatically
blocking intrusive ads within its
Chrome browser for desktop and
Android from Thursday 15
February.
The change, announced in June, will
see the dominant browser that is
used by over 56% of internet users
block some of the most intrusive
ads including full-page prestitial
ads, flashing animated ads and auto
-playing video ads with sound.
“A big source of frustration is
annoying ads: video ads that play at
full blast or giant pop-ups where
you can’t seem to find the exit
icon,” said Rahul Roy-Chowdhury,
vice president for Chrome. “These
ads are designed to be disruptive
and often stand in the way of
people using their browsers for
their intended purpose —
connecting them to content and
information. It’s clear that annoying
ads degrade what we all love about
the web.”
Read more ...The Gaurdian.com

http://bigbearcc.org
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Helpline
The following members have
generously offered to help you with your PC
problems by phone or by email:
Windows Beginners .................Yomar Cleary
909.214.6990
ycleary@charter.net
Microsoft Windows ............. Rosemary Lloyd
909.547.7257
Rosemary@bigbearcc.org
MS Outlook .......................... Rosemary Lloyd
909.547.7257
Rosemary@bigbearcc.org
MS Excel ................................... Yomar Cleary
909.878.5622
ycleary@charter.net
MS Publisher ........................... Yomar Cleary
909.214.6990
ycleary@charter.net
CD Burning .......................... Rosemary Lloyd
909.547.7257
rosemary@bigbearcc.org
Computer Upgrades................... Marc Busch
949.609.9266
bigbearjedi@charter.net

Officers and Key Leaders
President ..............................
Yomar Cleary
909.214.6990
ycleary@charter.net
Vice President…. .……….…......... Marc Busch
949.609.9266 ………....bigbearjedi@charter.net
Treasurer .................................. Tom Brandau
213.446.1315
tombran44@gmail.com
Secretary ..................................... Sandi Ybarra
909.585.8318
sandiscabin@gmail.com
Director at Large …...…....……… Jerry Merino
909.585.8714
gmerino@charter.net
Director at Large .……...…......... Del Johnson
909.584.9017……...deljohnson_Is@yahoo.com
Director at Large .……….......... Bill Treadwell
909.730.4625
treadwell@bigbearcc.org
Webmaster ............................ Rosemary Lloyd
909.547.7257
Rosemary@bigbearcc.org
Assistant Webmaster ………..….Bill Flanagan
909.866.9379
bill@bigbearcc.org

The Computer Club provides training at
the monthly meetings when there is no
presenter.

Newsletter Editor ....................... Bill Treadwell
909.730.4625
treadwell@bigbearcc.org

Persons with all levels of computer
knowledge are welcome to attend the
club’s open meetings.

Publicity ......................................Yomar Cleary
909.214.6990
ycleary@charter.net

Your First 2 visits are free!
Bring a friend.

Annual Membership is $25 and spouse $5.
All recurring membership dues are due in
January.

Equipment Chair .......................... Marc Busch
949.609.9266 ………....bigbearjedi@charter.net
Technical Advisor … ....................... Jim Lloyd
909.584.9358
inquiries@sugarloafpc.com
Refreshments Chair ……..…… Sharon Teeter
909.585.2026
sharonteeter1@verizon.net
Historian ......................................Sandi Ybarra
909.585.8318
sandiscabin@gmail.com

THE BEAR WANTS YOU
TO SHARE A TIP
Send tips to
treadwell@bigbearcc.org

http://bigbearcc.org

Sunshine Chair .......................... Angie Pezina
909.866.2314
apezina@gmail.com
Hospitality Chair……...…….…Linda Sharman
310.384.8858
lsharman49@gmail.com
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General Information and Membership Application
BIG BEAR COMPUTER CLUB, INC.
P. O. BOX 645 – BIG BEAR CITY, CA 92314

Membership Application—$25.00 – Associate $5
You can pay your dues at the monthly meeting, by mail -- make checks to Big Bear Computer
Club, or by Pay Pal (Go into our website www.bigbearcc.org and go to “Donate.”)

□New □ Renewal

Membership Benefits
 Monthly Meeting presentation and demonstration
of popular hardware and
software
 RAM (Q&A) sessions
 Tech News and Virus
Alerts
 Door prize drawings
 Bearly Bytes, our awardwinning monthly newsletter emailed

 Website: bigbearcc.org
 Free Software Review
 Member Help Line
 Member E-mail Notifications
 Member-only Discounts
 Training workshops

Full Name

□ Update my Information

___________________________________________________________________

Mailing Address _______________________________________________________________
City, State, Zip ________________________________________________________________
Home Phone _(______)___________________

Cell Phone_(_____)__________________

E-mail address ________________________________________________________________
Adding Associates
For each Family Member (s) add $5/year towards your dues.
I agree that Big Bear Computer Club may use such photographs of me with or
without my name and for any lawful purpose, including for example such
purposes as publicity, newsletter, advertising and web content.

□ Yes □ No Your initials: _________
Mail your application and check for dues to:
BCC Treasurer
PO Box 645
Big Bear City, CA 92314
Or bring your application and dues to a monthly general meeting

All this for only
$25 per year!!
Computer Club meetings are held
in the Big Bear Senior Center

Mailing Address:
Big Bear Computer Club
PO Box 645
Big Bear City, CA 92314

http://bigbearcc.org
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